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L  E  S  S  O  N  4 

Additional PowerPoint features 

Lesson objectives 
To become familiar with PowerPoint toolbar and menu options, you will: 

a Move and customize PowerPoint toolbars by using the mouse and the toolbar shortcut 
menu. 

b Customize the PowerPoint environment by using the Options dialog box. 

c Automate slide production by using the Clipboard and the Summary Slide feature. 

d Check consistency in a presentation by using AutoCorrect and the Style Checker. 

Suggested teaching time 30-40 minutes 
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a Customizing PowerPoint toolbars 
Concepts > When you start PowerPoint, the Standard, Formatting, and Drawing toolbars 

are displayed by default in the standard, three-pane view. The toolbars that are 
available depend on the view that is displayed. For example, in Slide Sorter 
view, the Slide Sorter toolbar is displayed by default and the Formatting and 
Drawing toolbars are not available. 

You can add or remove toolbars by selecting them from the toolbar shortcut 
menu or from the Customize dialog box. The Options page in the Customize 
dialog box also contains options to display large icons or to turn off the display of 
ScreenTips. 

Task A-1: Viewing toolbar options and removing toolbars 
ü Before you begin: There are no presentations open. 

What you do  Comments/Prompts 

1. Open Results Presentation  

2. Display the toolbar shortcut  
menu 

(Right-click on any toolbar.) 

3. Observe the toolbars that 
are checked 

The Standard, Formatting, and Drawing toolbars 
are checked. (The Outlining toolbar might also be 
checked.) 

4. Uncheck Formatting To remove the Formatting toolbar. 

5. If necessary, display the 
toolbar shortcut menu and 
uncheck Outlining 

 

Practice Task 

 Display the Formatting 
toolbar. 

 

 

Moving the toolbars 
Concepts > You can customize your screen by moving toolbars to different locations. To 

move a toolbar, place the mouse pointer between buttons on the toolbar (or on a 
separator), and drag the toolbar to a new location. As you drag, an outline of the 
toolbar is displayed. You can make a toolbar float by dragging it into the slide 
area. When a toolbar is a floating toolbar, you can move it around on the screen 
by dragging its title bar. To anchor the toolbar to its original location, double-
click on a blank area of the toolbar. 
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Task A-2: Moving the toolbars 
ü Before you begin: Complete the Practice Task at the end of Task A-1. 

What you do  Comments/Prompts 

1. Place the mouse pointer on 
the separator between the 
Standard and the 
Formatting toolbars 

 

The mouse pointer changes to a four-way arrow. 

2. Press and hold the left 
mouse button 
 
Drag the Formatting 
toolbar to the center of the 
screen 

 
 
 

 

(Drag by the title bar.) The toolbar is floating. You 
can move the toolbar anywhere on the screen. 

3. Drag the Formatting 
toolbar under the Standard 
toolbar 

 

Practice Task 

 Return the Formatting 
toolbar to its original 
position, to the right of the 
Standard toolbar. 

 

(Drag by the separator located at the beginning of 
the toolbar.) 

 

Customizing toolbars 
Concepts > You might find that some of the toolbars contain buttons that you seldom use. 

You can customize any of the toolbars by removing buttons that you do not use 
and adding buttons that you consistently use. 

Dragging toolbars is 
difficult for some 
students with limited 
mousing skills. You 
may want to 
demonstrate this task. 

Explain to students 
that if they do not like 
having both the 
Standard and 
Formatting toolbars on 
one line, they can drag 
one toolbar under the 
other. 
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To add or remove buttons: 

1. Display the toolbar shortcut menu. 
2. Choose Customize. 
3. To remove a button, drag it off the toolbar. 
4. To add a button, on the Commands page, select a command from the 

Categories list. Select the button you want to add, and drag it to the toolbar 
to which you want to add it. 

5. Click on Close. 

To reset the toolbar to the default, in the Customize dialog box, verify that the 
Toolbars tab is selected, and click on Reset. 

Task A-3: Adding and removing buttons 
q Objective: To add the Find button to the Standard toolbar. 
ü Before you begin: Complete the Practice Task at the end of Task A-2. 

What you do  Comments/Prompts 

1. Display the toolbar shortcut 
menu 

Right-click on any toolbar. 

2. Choose _Customize..._  
 
If necessary, drag the 
Customize dialog box down  

To display the Customize dialog box. 
 
So the toolbars are visible. The Standard and 
Formatting toolbars are now on separate lines. 

3. Select the Commands tab 
 
In the Categories list box, 
select Edit 

 
 
To display the Edit options in the Commands list 
box. 

4. In the Commands list box, 
select the Find button 

 

(You will need to scroll down.) 

5. Drag the Find button to the 
Standard toolbar and place 
it between the Print button 
and the Spell Check button 
 
Release the mouse button 

 

To add the Find button to the Standard toolbar. 
PowerPoint adjusts the size of the buttons to fit on 
the toolbar. 
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6. On the Customize dialog 
box, select the Toolbars tab 
 
Verify that Standard is 
checked 
 
 
 
 
Click on Reset... 
 
 
 
 
 
 
Click on OK 

 

 
 

 

To return the Standard toolbar to its default state. 

 

Personalized menus and toolbars 
Concepts > If you are more comfortable with the way menus and toolbars are handled from 

earlier versions of Microsoft Office, you can revert back by making a few 
changes on the Options page of the Customize dialog box. For example, you can 
have the Standard and Formatting toolbars on two separate rows. You can also 
have the menu choices remain unchanged rather then cycling to the most 
recently used commands. 

Task A-4: Additional toolbar options 
What you do  Comments/Prompts 

1. Verify that the Customize 
dialog box is displayed 

(If not, display the toolbar shortcut menu and 
choose Customize.) 

2. Select the Options tab 
 
Under Personalized Menus 
And Toolbars, uncheck 
Standard And Formatting 
Toolbars Share One Row 

 

3. Click on the Reset My Usage 
Data button 
 
 
 
 
 
 
 
Click on Yes 

 

The Standard and Formatting toolbars are 
contained on separate rows. 
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4. Under Other, uncheck List 
Font Names In Their Font 

 

5. Click on Close To close the Customize dialog box. 

6. On the Formatting toolbar, 
click on the Font drop-down 
arrow 

The installed font names are displayed in their 
fonts. 

Practice Task 

 Return the toolbar and 
menu options back to their 
defaults. 
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b Other customization options 
Concepts > You can further customize PowerPoint by using the Tools, Options menu choice, 

which displays the Options dialog box. The Options dialog box is composed of the 
following six pages: 

• The View page enables you to choose whether or not to view the status bar 
and vertical ruler. You can also control the Startup dialog box and the New 
Slide dialog box, as well as slide show features. 

• The General page enables you to control the number of recently used files, 
macro virus protection, and user information. 

• The Edit page enables you to control the appearance of quotation marks, 
spacing when deleting and pasting text, the maximum number of undos, and 
the drag-and-drop feature. 

• The Print page enables you to control background printing, TrueType fonts, 
and options for printing the current document. 

• The Save page enables you to control fast saves, full text search information, 
AutoRecover information, and the Save File As Type default. 

• The Spelling And Style page enables you to control features for checking the 
spelling as you type, when to suggest correct spellings, and ignore options. 

Task B-1: Examining View options 
ü Before you begin: The file Results Presentation is open. 

What you do  Comments/Prompts 

1. Choose _Tools_  _Options..._ To display the Options dialog box. 

2. Verify that the View tab is 
selected 
 
Observe the options 

 
 
 
If Startup Dialog is not checked, then that dialog 
box will not be displayed upon startup. If New Slide 
Dialog is not checked, you will automatically begin 
each new presentation with a title slide. You can 
also control some aspects of the slide show 
environment from this page. 

3. Uncheck Status Bar 
 
Uncheck End With Black Slide 
 
Click on OK 

To hide the display of the status bar. 
 
To uncheck the option that signals the end of a slide 
show by displaying a black slide. 

4. Observe the bottom of the 
screen 

The status bar is not displayed. 

5. Move to the last slide in the 
presentation 
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6. Click on the Slide Show 
button  

To display this presentation as a slide show. 

7. Click the left mouse button 
on the blue background 

To exit the slide show and return to the slide. 

Practice Task 

 Use the Options dialog box 
to display the status bar 
and end slide shows with a 
black slide. 

 

 

Task B-2: Examining Edit options 
What you do  Comments/Prompts 

1. Choose _Tools_  _Options…_ 
 
Select the Edit tab 

To display the Options dialog box. 

 

2. Observe the options 

 

Among other options, you can choose to insert Smart 
Quotes, rather than the standard quotation marks. 
You can have extra spaces automatically removed 
when you delete text and necessary spaces added 
when you paste text. You can also enable the drag-
and-drop feature to move and copy text. 

3. Close the Options dialog 
box 
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c Automating slide production 
 

The following new software feature is discussed in this topic: 

• Collect and paste with the Office Clipboard 
 
Concepts > If your slide show contains repetitive information, there are a number of ways to 

duplicate that information without re-creating slides. One way is by copying and 
pasting information to and from the Clipboard. Another way is by creating a 
summary slide. By creating a summary slide, you eliminate the need to retype 
the content of your presentation. 

Copying multiple items 
All Office applications make use of a standard HTML-based Clipboard, which 
enables Office applications to share information easily. For example, you can 
copy text in Word, switch to Excel and copy a drawing, switch to PowerPoint and 
copy a bulleted list, and then switch back to Word and paste the collection of 
copied items. The Clipboard can store up to twelve items. If you try to copy 
another item when the Clipboard already contains twelve, a  message prompts 
you to remove the first item, or not copy the thirteenth item. The collected items 
remain in the Clipboard until you exit all Office programs. 

Pasting multiple items 
When placing multiple objects on the Clipboard, the Clipboard toolbar is 
displayed. The Clipboard toolbar enables you to easily locate and paste objects 
into a slide. You can click on the Paste All button on the Clipboard toolbar to 
paste all of the items contained on the Clipboard. You can also paste individual 
items by clicking on one of the Picture buttons. If you choose Edit, Paste (or 
Ctrl + V), the last item you copied is pasted. 

Task C-1: Duplicating slide content 
q Objective: To use the Clipboard to copy several slides to paste into another 

presentation. 
ü Before you begin: The file Results Presentation is open. 

What you do  Comments/Prompts 

1. Move to Slide 2 
 
Choose _Edit_  _Select_All_  

The slide containing the cloud clip art. 
 
To select all of the objects on the slide. 

2. Display the toolbar shortcut 
menu and choose _Clipboard_ 

To show the Clipboard toolbar. 

3. Choose _Edit_  _Copy_  To copy the contents of Slide 2 to the Clipboard. 
4. Move to Slide 3 

 
Choose _Edit_  _Select_All_ 

 
 
To select the entire slide. The Picture toolbar is 
displayed. 

5. If necessary, close the 
Picture toolbar 

(Click on the Close button.) 

6. Choose _Edit_  _Copy_  To copy the contents of Slide 3 to the Clipboard. 

what’s new  
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7. Open New Service 
Presentation 
 
Move to Slide 4 
 
Insert a new slide 
 
Select the Blank AutoLayout 

Follow your instructor’s directions to locate the 
Student folder. 
 
The last slide in the presentation. 
 
(Click on the New Slide button.) 

8. On the Clipboard toolbar, 
click on the Picture 1 button 

 

The objects from Slide 2 of Results Presentation are 
copied to Slide 5 of New Service Presentation. 

9. Insert a new blank slide (Click on the New Slide button and select the Blank 
AutoLayout.) 

10. On the Clipboard toolbar, 
click on the Picture 2 button 

 

The objects from Slide 3 of Results Presentation are 
copied to Slide 6 of New Service Presentation. 

11. Move to Slide 1 
 
View the entire slide show 

 
 
(Click on the Slide Show button.) 

12. Close the file Results 
Presentation 
 
If prompted, do not save 
changes 
 
Save the file as My New 
Service Presentation 

(Right-click on the Results Presentation taskbar 
button and choose Close.) 
 
The file New Service Presentation remains open. 

 

Students might notice 
that there is a color 
shift after they paste 
slide contents from 
one presentation to 
another. If this 
happens, they can 
recolor the graphic 
objects. 

Students can click on 
the Close button 
located on the toolbar 
or the Close button on 
the title bar. 
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Adding a summary slide 
Concepts > If you need to create a summary of a presentation that lists each slide title, 

either for an overview at the start of a presentation or a review at the end of a 
presentation, PowerPoint enables you to create a summary slide. A summary 
slide is created in the Slide Sorter view. The summary slide lists the titles of 
selected slides on a single slide as bullets. 

To create a summary slide: 

1. Switch to Slide Sorter view. 
2. Select the slide that you want to include in the summary. 
3. Click on the Summary Slide button located on the Slide Sorter toolbar. 

Task C-2: Creating a summary slide 
q Objective: To select only the slides that contain a title to be included in the 

summary slide. 
ü Before you begin: The file My New Service Presentation is open. 

What you do  Comments/Prompts 

1. Change to Slide Sorter view 
 

2. Move Slide 5 in front of 
Slide 1 
 
Move Slide 6 between Slides 
1 and 2 

(Click on Slide 5 and drag it to the left of Slide 1.)  
 
 
(Click on Slide 6 and drag it between Slides 1 and 
2.) To move these slides away from the slides that 
will be included in the summary slide. 

3. Select Slide 3  

4. While holding the S key, 
select Slide 6 

To select Slides 3 through 6 (the slides that contain 
a title). 

5. Click on the Summary Slide 
button  

To create a summary slide and insert it as the first 
slide before the selected slide. 

& Let’s move all 
the slides that will 
appear in the 
summary slide (the 
slides that contain a 
title) next to each 
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6. Change to Normal view 
 
Observe the summary slide 

 
 

 

The summary slide contains each slide title as a 
bullet. In addition, the summary slide contains a 
bullet for the summary slide. 

7. Save and close the 
presentation 
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d Using AutoCorrect and Style Checker 
Concepts > The AutoCorrect feature automatically corrects common typing errors as you 

work. The Style Checker automatically checks consistency across your slides, 
such as verifying the case of bulleted text. 

Using AutoCorrect 
The AutoCorrect feature automatically corrects words beginning with two 
capital letters, the uncapitalized first letter of a sentence, uncapitalized names of 
the days of the week, and accidental use of the Caps Lock key. AutoCorrect 
contains a large list of commonly misspelled words (such as “teh”), which are 
automatically corrected as soon as you press the spacebar or type punctuation. If 
there is a word that you consistently mistype or would like to abbreviate, you 
can add the word to AutoCorrect. 

To add an AutoCorrect entry: 

1. Choose Tools, AutoCorrect. 
2. In the Replace text box, type the word as you would normally misspell it. 
3. In the With text box, type the word as you want it to appear in your 

presentations. 
4. Click on Add. 

Task D-1: Using the AutoCorrect feature 
ü Before you begin: There are no presentations open. 

What you do  Comments/Prompts 

1. Open Style Presentation 
 
Choose _Tools_   
_AutoCorrect…_  

 
 
To display the AutoCorrect dialog box. 

2. Observe the checked 
options in the dialog box 

The AutoCorrect feature automatically corrects a 
word if it starts with two capital letters. Days are 
automatically capitalized. 

3. Observe the copyright 
symbol 

If you type the letter “c” in parentheses, the 
AutoCorrect feature recognizes that it is meant to be 
the copyright symbol and replaces it. 
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4. In the Replace text box, 
type fro 
 
In the With text box, type 
for 
 
Click on Add 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on OK 

 
To create the “fro” AutoCorrect entry. 

5. Move to Slide 6 (Burke Properties Presents.) 

6. Click on the bulleted text 
placeholder 
 
Type RElocation 
 
Press s 
 
 
Type assistance 
 
Press R 

 
 
 
 
 
The AutoCorrect feature automatically changes the 
uppercase E to a lowercase letter when you press 
the spacebar. 
 
 
To create a new bullet. 

7. Type No fee fro inspections 
 
Press R 

When you press the spacebar after the word “fro,” 
the AutoCorrect features changes the word to “for.” 

8. Type Movers called MoveWise 
(tm) 

The AutoCorrect feature replaces the letters “tm” in 
parentheses with a trademark symbol. 

9. Click away from the 
bulleted text 

 

 

The text “Relocation” 
is intentionally typed 
incorrectly. 

Make sure students 
watch the word “fro” 
change to “for.” 

The red line under 
MoveWise indicates 
that the spelling 
checker does not 
recognize this word. 
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Deleting AutoCorrect entries 
Concepts > If there is an AutoCorrect entry that you entered incorrectly or one that you no 

longer need, you can delete it. 

To delete an AutoCorrect entry: 

1. Choose Tools, AutoCorrect. 
2. In the list box, select the entry you want to remove. 
3. Click on Delete. 

Task D-2: Deleting an AutoCorrect entry 
What you do  Comments/Prompts 

1. Choose _Tools_   
_AutoCorrect…_  

To display the AutoCorrect dialog box. 

2. If necessary, click in the 
Replace text box 
 
Type fro 

To activate the text box. 
 
 

 

To scroll to and select the word “fro.” 

3. Click on Delete To delete the entry from the list box. 

4. Click on OK To close the dialog box and return to the slide. 
 

Using the Style Checker 
Concepts > Many aspects of a presentation need to be checked before it is formally 

presented. For example, you should check spelling and punctuation. You should 
also check for visual clarity, such as the number of different fonts and bullets 
used in the presentation. 

The Style Checker can perform these tasks for you automatically and you can 
change the style options that PowerPoint checks for. 
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To change the Style Checker options: 

1. Choose Tools, Options. 
2. Select the Spelling And Style tab. 
3. Under Style, click on Style Options to display the Style Options dialog box. 
4. Make any necessary changes on the Case And End Punctuation page or the 

Visual Clarity page. 
5. Click on OK to close the Style Options dialog box. 
6. Click on OK to close the Options dialog box. 

Task D-3: Observing Style Checker options 
What you do  Comments/Prompts 

1. Choose _Tools_   
_Options…_  

To display the Options dialog box. 

2. If necessary, select the 
Spelling And Style tab 
 
Under Style, click on Style 
Options… 

 
 
 

 

To display the Style Options dialog box. 

3. Observe the options on the 
Case And End Punctuation 
page 

You can set the case for slide titles and body text. 
You can also choose to remove, add, or ignore end 
punctuation in slide titles and body text. 

4. Observe the options on the 
Visual Clarity page 

By default, these options follow accepted 
presentation guidelines. For example, the number of 
fonts should not exceed 3, and the number of bullets 
should not exceed 6. 

5. Click on OK 
 
Click on OK 

To close the Style Options dialog box. 
 
To close the Options dialog box and return to the 
slide. 

 

Checking a presentation 
Concepts > PowerPoint automatically checks your presentation for consistency and style 

and indicates problems on the slide by using a light bulb icon. You can fix the 
problem or ignore the light bulb. To fix the problem, click on the light bulb, and 
then click on the option you want in the list. 
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Task D-4: Using the Style Checker 
ü Before you begin: Slide 5 is in Normal view. 

What you do  Comments/Prompts 

1. Point to the light bulb in 
front of the bulleted text on 
Slide 5 
 
Click the mouse button 

 
 
 
 
To display the Office Assistant with the title 
Capitalization. 

2. Review the capitalization 
options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on Change The Text To 
Sentence Case 

 

The text in this placeholder should be sentence case. 
 
Any incorrect capitalization is corrected. 

3. Move to Slide 7 
 
Click on the light bulb 
 
Click on Ignore This Style Rule 
For This Presentation Only 

 

4. Save the file as My Style 
Presentation 
 
Close the presentation 

 

 

Students may not have 
a light bulb. If they 
don’t, have them open 
the Office Assistant 
and have them type 
Capitalization in the 
What Would You Like 
To Do text box. 
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( Practice Unit for Lesson 4 
In this activity, you will copy slide content and create a summary slide. 

1. Open Practice Summary. 
2. Copy the 1-800-WHY-RENT clip art to the title slide. 
3. Create a summary slide for the entire presentation. 
4. Move to the beginning of the presentation. 
5. Run the Style Checker on this presentation and make any necessary 

changes. 
6. Save the file as My Practice Summary 
7. Close the file. 
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) Wrap-up for Lesson 4 

a Describe the steps for moving a toolbar. 
Place the mouse pointer on a separator or between any two buttons on a 
toolbar, and drag the toolbar to a new location. 

b What tab in the Options dialog box enables you to change slide show 
features? 
View. 

c How many items can the Clipboard hold at one time? 
Twelve. 

Describe the method of automating slide production through the use 
of a summary slide. 
A summary slide consists of the titles from the selected slides. The titles 
are used as bullets on a summary slide. 

d What menu bar command operates both AutoCorrect and Style Checker? 
Tools. 

 



 

 

 


